
Chapter 1

How to Turn On Your Mac
(and What to Do Next)

In This Chapter
� How to turn the Mac on (and off)

� New meanings for old words like mouse, menu, and system

� Doing windows

� Mindlessly opening and closing folders

Once you’ve paid for your Mac, the hard part is over. Take it home, open
the carton, and haul it out of its sculptured Styrofoam blocks. 

Now you should set aside, oh, a good two minutes for getting it all plugged in
(see Chapter 20). 

At this moment, then, you should have a ready-to-roll Mac on your desk, in all
its gorgeous glory, and a look of fevered anticipation on your face.

Switching On the Mac
In this very first lesson, you’ll be asked to locate the On button. It’s round, it’s
on the front, side, or top of the computer, and it bears the universal symbol
for Mac On-Turning, like this:
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8 Part I: For the Absolute Mac Virgin

Try pushing this button now. If the Mac responds in some way — a
sound plays, the screen lights up, missiles are launched from the
Arizona desert — then your machine is working. 

If pressing that button doesn’t do anything, then your Mac isn’t
plugged into a working power outlet. I’ll wait here while you get that
problem sorted out.

If your On-button experiment was successful, you hear a chord, and
after a few seconds, an image appears on the screen. Now you’re
treated to the famous Apple logo, revered by millions. It looks like this:

(In the rare event that your Apple logo appears like this —

On button
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— your screen is upside-down.)

As the startup process proceeds, a progress bar inches its way across the
screen as it fills with what looks like shimmering blue water. It telegraphs
how much longer you have to wait.

What Happens Next
Life is never easy for computer-book authors (except for the screaming mobs
of attractive fans in bookstores, of course). Pity the guy who has to explain
what happens once you’ve turned on the Mac.

The truth is, you may encounter any of three things at this point. If the
machine is fresh out of the box, you’re guided through an interview in which
you set the computer’s clock and perform other digital paperwork. If it’s
already been set up, you might be asked to choose your name from a list
before gaining access. And you may go straight to the swirling blue of the
Mac desktop picture, ready for work. The following pages tell you what to do
in each of these three situations.

All three situations, by the way, require your mastery of the mouse. If you’ve
never used the mouse before, read the sidebar called “Mouse College.” 

The Setup Assistant
If you are the first person ever to turn on the Mac, the computer takes this
opportunity to interview you, one question per screen. It’s kind of unfortu-
nate that your computing experience has to begin with paperwork instead of,
say, blasting aliens, but that’s life in the fast lane.

In any case, this setup program asks you what country you’re in (twice), what
your name and address are, and whether or not you want to get junk mail. Fill
in the answers by clicking the multiple-choice buttons with the mouse and
typing into the empty boxes with the keyboard. When you’re finished with
each screen, click the Continue button with your mouse.
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Eventually, you arrive at a Create Your Account screen. It’s somewhat technical
looking, but as computer screens go, this one is pretty important. 

This is where you identify yourself to the Mac. Fill in the boxes called Name
(example: Huckleberry Finn), Short Name (example: Huck), Password (don’t
forget it!), and Password Hint (which the Mac will show you if you ever do
forget your password). 

If this is your own personal Mac that nobody else uses, count your blessings:
You’ll only rarely need to type in this password. If you share the computer
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Mouse College
The mouse is the transparent, capsule-like thing
on the desk beside your keyboard. Having trou-
ble visualizing it as a rodent? Think of the cord
as its tail and (if it helps you) draw little eyeballs
on the domed surface facing you.

To use the mouse, keep it turned so that the cord
always points away from you. 

Now then, scrape the mouse across the desk
(or mouse pad). See how the arrow pointer
moves across the screen? For the rest of your
life, you’ll hear that pointer called the cursor.
And for the rest of your life, you’ll hear moving
the mouse called moving the mouse.

Try lifting the mouse off the desk and waving it
around in midair like a remote control. Nothing
happens, right? The mouse controls the cursor
only when it’s on a flat, opaque surface. (An
electronic eye on the bottom of the mouse is
constantly scanning the table surface. That’s
how it knows when you’re moving it. That’s also
why dragging it across a glass or mirrored sur-
face is a mean prank to play on this helpless
little gadget.)

You can pick up the mouse when you run out of
desk space, but the cursor will stay in place on

the screen. Only when you set the mouse down
and begin to roll it again will the cursor continue
moving.

Now put your index finger on the far end of
the mouse and briefly press down (and then
release). If all goes well, you should feel the
mouse click.

Congratulations — you’ve learned how to click
the mouse. You’ll encounter that instruction over
and over again in your budding computing life.

Oh — and if you have a laptop (an iBook or
PowerBook), you don’t have a mouse. Studies
have shown that rolling an ovoid plastic box
across the thigh of the guy next to you on the
plane can have unpleasant results, ergonomi-
cally and socially speaking. Therefore, you’ve
been given, instead, a trackpad. The principle is
the same: Stroke the pad away from you, and
the cursor moves up the screen. Instead of a
mouse button, you have a broad, clicky button
nestled against the pad.

I won’t mention this distinction again, because if
you’re smart enough to have bought a laptop,
you’re smart enough to translate future refer-
ences to the mouse into trackpad terms.
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with other people in your family, school, or office, you’ll be grateful that that
little password keeps your own stuff safe from the inquiring minds of your
comrades. (Details on this user accounts feature in Chapter 13.)

When you click Continue again, you’re asked how you want to get onto the
Internet. 

� If you don’t have an Internet account, click “I’d like a free trial account
with Earthlink.” (When you click an option like this, you can click either
the little round button or the sentence itself.) When you click Continue,
you’ll be guided through the process of getting an account with Earthlink,
one of the biggest Internet service companies. It won’t let you into its
hallowed halls, however, without your credit-card number, even though
the first month is free. (Your Mac will actually dial into the Internet
during this process, so make sure that you’ve connected a phone wire
from the Mac’s phone jack to a wall phone jack.)

� If you already have an Internet account, choose “I’ll use my existing
Internet service.” When you click Continue, you’ll be asked what kind of
connection you have (telephone modem, cable modem, and so on), and
then asked for a lot of technical parameters like IP addresses and DNS
addresses. Unless you’re some kind of competent Internet guru, skip this
option and set up your account later, as described in Chapter 6.

� If all of this red tape is giving you a tension headache, you can always
confront the Internet later. In that case, choose “I’m not ready to connect
to the Internet” and click Continue. You can set up an Internet account
when you’re reading Chapter 6.

The interview continues. You’ll be asked to register (click Register Later,
unless you’re a real fan of junk mail). You’ll be shown a map of the world,
which you can click to specify your time zone. You’ll be asked to set the
Mac’s clock. You’re invited to sign up for Apple’s $100-a-year .Mac account
(see Chapter 6; decline for now).

Finally, the Mac thanks you for your bureaucratic efforts. Click the Done
button.

At last, the colored full-screen pattern, called the desktop, appears.
Congratulations! You’ve arrived. 

(If you saw anything else during the startup process — a blinking question-
mark icon, a strange error message, or thick black smoke — you’ve just met
your first computer problem. Proceed directly to Chapter 16, which is all
about troubleshooting.)
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The Welcome screen
If turning on the Mac produces a list of people’s names, like this —

— then you’re not the first person to use this machine. Somebody has beat
you to the setup process. Click your name, if you see it; type your password,
if you’ve been given one; and then read on.

In any case, you’ll find an explanation of this name-and-password signing-in
process at the end of Chapter 13. 

The desktop and menu bar
For some people, turning on the Mac takes you directly to the desktop, as
shown in the upcoming illustration.

You also wind up here after encountering the Setup Assistant or list of names
described in the previous pages. In any case, the machine is officially on now,
and ready to do work for you. 
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Let’s try some real computing here. Move the cursor up to the lightly striped
strip at the top of the screen. It’s called the menu bar, named after a delightful
little pub in Silicon Valley. Touch the arrow on the Ú logo at the upper-left
corner of the screen. (The tip of the Mac’s arrow is the part you need to worry
about. Same thing with real-life arrows, come to think of it.)

Pointing to something on the screen in this way has a technical term: pointing.
(Think you’re going to be able to handle this?)

The big turn-off
Before we get into 3-D color graphs, space-vehicle trajectories, and DNA
analysis, I guess I should tell you how to turn the Mac off.

In a pinch, sure, you can just yank the power cord out of the wall. But regu-
larly turning off the Mac by chopping off its power can theoretically invite
technical problems with the hard drive.

Instead, you’re supposed to turn off your Mac using one of the commands
listed in the Ú menu that you opened just a moment ago. Click the Ú logo;
when the list of commands appears, roll the mouse downward so that each
successive command turns dark. When each menu command turns dark, it’s
said to be highlighted.

(The only commands that don’t get highlighted are the ones that are dimmed,
or grayed out. They’re dimmed because they don’t make any sense at the
moment. For example, if no disc is in the CD-ROM drive, choosing Eject
wouldn’t make any sense. So the Mac makes that command gray, which
means it’s unavailable to you.)

If you’ve had enough of a computer lesson for now, let the cursor come to
rest on the Shut Down command — and then click the mouse again. The com-
puter promptly shuts itself off. See? This thing’s no harder than a toaster.

(Another way to turn off the Mac: Press the power button again. This box
appears:
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Click Shut Down with the mouse, or press the Return key, which triggers the
blue, pulsing button in any box on the screen.) 

If you’re ready to read on, though, confident that you now know how to turn
this thing off, move the mouse cursor away from the menu and click any-
where else on the screen. The Mac, amazingly, does nothing at all but
continue looking extremely cool.

Why not to turn off the Mac
Believe it or not, many Mac owners never turn the machine off. Instead,
whenever they’re not using it, they let the Mac drift off to sleep. 

When the Mac is asleep, the screen is dark, the components inside stop
whirring, all activity stops, and electricity consumption slows to a trickle.
When you press a key later, the computer brightens right up. Whatever was
on the screen is still there, ready for you to begin working again.

When you first buy a Mac, it’s set to sleep automatically several minutes after
you’ve stopped using it. But you can also make the machine sleep instantly,
on your command, which is useful when you’re browsing the “Survivor” Web
site at work just as the boss walks by.

To do so, open the Ú menu again and then click the Sleep command. The
Mac blinks right off to sleep. (Or press the power button; in the resulting box
on the screen, click the Sleep button.) 

While it’s dozing, a little white or bluish light near the screen (or on the edge,
if it’s a laptop) stays on, slowly “breathing” on and off, your cue that the
machine isn’t entirely off. It makes a handy night light for the office (well, if
your office is about one inch wide).

Desktop, Dock, and Icons
Take a look around the screen. At the bottom is a row of icons called the
Dock. Most of these icons represent the various programs that came with
your Mac. (To find out their names, try pointing to them without clicking.)
The Dock is described in Chapter 3. 
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Near the upper-right corner of the screen, you see an icon, a little, inch-tall,
symbolic picture. Unless you’ve changed it, that icon is called Macintosh HD.

Icons represent everything in the Mac world. They all look different: One rep-
resents a letter you wrote, another represents the Trash can, another
represents a CD you’ve inserted. Here are some examples of icons you’ll
probably be seeing before long:

A CD A hard drive A folder A programA picture

DesktopMenu bar Hard-drive icon

Dock
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All systems are go
An operating system is the behind-the-scenes
software that runs your computer. But because
everyone’s in such a hurry these days, people
now just call it the OS. (Say it “O. S.,” not “oss.”)
Your computer, in fact, runs one of the most
advanced and beautiful operating systems on
earth: Mac OS X.

(That X is supposed to be a roman numeral 10.
Say “Mac Oh Ess Ten.” Don’t say “Mack Ossex,”
unless you want people to look at you funny.)

Just like car companies, Apple Computer piles
on a few new features to Mac OS X every year.
It distinguishes one version from the previous by
tacking on additional decimal points. Your Mac
may run Mac OS X version 10.1, or 10.2.8, or
even 10.3-point-something.

Want to find out what you’ve got? Get a pencil.

Remember the Ú logo in the upper-left corner
of the screen? Point your arrow cursor tip on the
apple and click the button to open the menu.
Click the first command here, About This Mac. A
window appears, like the one shown here,
revealing what version of Mac OS X you have. 

The version is a number you’ll need to know
later in this book and later in your life. Therefore,
take this opportunity to write it onto your Cheat
Sheet (the yellow cardboard page inside the
front cover of this book). You’ll find a little
blank for this information in the upper-left cor-
ner of your card, where it says, “Your System
version.”

But write it in pencil, because as Apple improves
its software, fixes bugs, and dreams up speed
enhancements, it will send them to your Mac
automatically the next time you connect to the
Internet. One day, you’ll wake up to discover
that your 10.3.1 machine now runs 10.3.2, or
whatever. Strange, useful — and freaky. 

(The instructions and pictures in this book, by
the way, depict Mac OS X 10.3-point-whatever,
nicknamed Panther.)

When you’re finished with this little piece of
homework, close the About This Computer
window by clicking the little, round, red button
in the upper-left corner — the Close button.
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You can move an icon by dragging it. Try this:

1. Point to the Macintosh HD icon.

2. Press and then hold down the mouse button continuously — and,
while it’s down, move the mouse to a new position.

This sophisticated technique is called, by the way, dragging. You’re drag-
ging the hard drive icon now.

3. Let go of the mouse button.

Other than the fact that there’s a Trash can near the bottom of the screen,
nobody’s really sure why they call this main screen the desktop. It has
another name, too: the Finder. It’s where you file all your work into little elec-
tronic on-screen file folders so that you can find them again later. The word
Finder even appears at the top of the screen, next to the Ú menu.

Macintosh syntax
Point once again to the hard-disk icon in the upper-right corner of the screen,
like this:

This particular icon represents the giant disk inside your Mac, known as the
hard drive or hard disk, which serves as your filing cabinet. It’s where the
computer stores all your work, all your files, and all your software.

So how do you see what’s in your hard drive? Where do you get to see its
table of contents?

It turns out that you can open any icon into a window, where you’ll see every
item inside listed individually. The window has the same name as the icon
you opened.
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Before we proceed, though, it’s time for a lesson in Macintosh syntax. Fear
not; it’s nothing like English syntax. In fact, everything that you do on the
Macintosh has this format: noun-verb. Shakespeare it ain’t, but it’s sure easy
to remember.

Let’s try a noun-verb command, shall we?

1. Click the hard-disk icon in the upper-right corner of the screen.

The icon turns black, indicating that it’s selected. Good job — you’ve just
identified the noun.

2. Using the mouse, click the File menu, and choose Open.

You guessed it — Open is the verb. And, sure enough, your hard disk
opens into a window, where you can see its contents. (If another window
was already on your screen, it immediately disappears to make way for
the Macintosh HD window.)

In the world of Macintosh, you always specify what you want to change
(using the mouse) and then you use a menu command to specify how you
want it changed. You’ll see this pattern over and over again: Select something
on the screen and then apply a menu command to it.

The complete list of window doodads
Look over the contents of your hard-drive window, as shown in the following
figure. (Everybody’s got different stuff, so what you see on your screen may
not exactly match the illustration.)

Better yet, look over the various controls and gadgets around the edges of
this window. Using these controls and buttons, you can do all kinds of neat
things to a window: stretch it, move it, or make it go away. These various gad-
gets are worth learning about — you’re going to run into windows
everywhere after you start working.
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Try out some of the little boxes and scroll bars. Click them. Tug on them.
Open the window and close it again. No matter what you do, you can never
hurt the machine by doing “the wrong thing.” That’s the wonderful thing about
the Mac: It’s the Nerf appliance.

Double-clicking in theory and practice
So far, all of your work in the Finder (the desktop) has involved moving the
mouse around. But your keyboard is useful, too. For example, do you see the
System folder, the one with a big X on it? Even if you don’t, here’s a quick way
to find it: Quickly type SY on your keyboard.

Close Button – Click here to close the window.

Sidebar – Lists folders, disks, programs,
and files for quick access.  You can drag
any icon into this area to list it here.

Horizontal Scroll Bar – If there's no blue handle, you're
seeing everything in the window (left to right, anyway).

Resize Box – Drag in any  direction to
make the window bigger or smaller.

Vertical Scroll Bar – 
It has a blue handle, 
indicating that you're
not seeing everything
in the window.  Drag
the blue, shimmery
handle to bring the
rest into view. 

Toolbar – Back and
Forward buttons,
view-changing
buttons, and a
Search bar.

Title Bar Icon – Click and hold, and then drag, to move the entire
window to the Trash, to another disk, or to another window.

Minimize Button – Click the yellow glob to hide the window.

Zoom Button –
Click to make the
window just big
enough to show
all its contents.

Title Bar – Drag anywhere in this
striped area to move the whole window.

Toolbar Button – Click to hide (or
bring back) the toolbar and the Sidebar.
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Presto, the Mac finds the System folder (which happens to be the first thing
that begins with those letters) and highlights it, in effect dropping it in front
of you, wagging its tail.

Now try pressing the arrow keys on your keyboard — right, left, up, down.
The Mac highlights neighboring icons as you do so.

Suppose you want to see what’s in the System folder. Of course, using your
newfound noun-verb method, you could (1) click the System folder to select
it and then (2) choose Open from the File menu.

But that’s the sissy way. Try this power shortcut: Point to the System folder
icon so that the tip of the arrow cursor is squarely inside the picture of the
folder. Keeping the mouse still, click twice in rapid succession. With stunning
originality, the Committee for the Invention of Computer Terminology calls
this advanced computing technique double-clicking.

If all went well, your double-click opened a different window, showing you the
contents of the System folder. (If it didn’t work, you probably need to keep
the mouse still or double-click faster.)

Remember this juicy golden rule: Double-click means “open.”

In your Mac life, you’ll be asked (or tempted) to click many an item on-screen:
buttons that say “OK”; tools that look like paint brushes; all manner of multiple-
choice buttons. In every one of these cases, you’re supposed to click once.

The only time you ever double-click something is when you want to open it.
Got it?

One window
Now you have the System window open. Well, that’s just great, but what hap-
pened to the hard drive window?

The Mac tries to keep your life simple by showing you only one window at a
time. When you open one folder, its window replaces whatever window you
were just looking at. It works like a TV: You can change channels, but the
frame around your screen always looks the same.

That’s all great, but what if you want to backtrack? What if, now that you’ve
savored the System folder for a moment, you want to return to the Macintosh
HD window that you opened first?

That’s what the Back button is for. Just click the button to go back to what-
ever window you had open before. In fact, if you’d opened several folders in
succession, you can click the Back button repeatedly for a little reverse slide
show of the windows you’ve recently opened.
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Multiple windows
This business of keeping only one window before you at all times is fine for
timid beginners, and it certainly keeps your screen tidy. But sooner or later,
you’re going to wish you could open two windows simultaneously — when
you want to move a picture or a chapter from one window into another. 

Try this: From the File menu, choose New Finder Window. Presto: A second
window appears. (It’s probably the window where you’re supposed to keep
all your stuff, the one that bears your name — your Home folder. Details in
Chapter 2.) 

You can tell that this window is in back,
because it looks sort of faded.  Click anywhere

in the window to bring it to the front.

You can tell that this window is in front,
because its title bar is bright and bold.
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Windows on a computer are like pieces of paper on a desk: There may be a
whole pile of them, but only one can be on top. And on a Mac, you bring a
window to the top just by clicking it. 

Take a stress-free moment to prove the point, using the two windows now
before you: Click the back one to bring it forward; then click the one that was
in front to bring it to the front again. To move a window, drag it with the
mouse, using anything that looks like brushed metal as a handle (like the
strip at the top — the title bar).

When you’re finished goofing around, close each window by clicking its Close
button (the little red glob of Colgate Very Berry Gel in the upper-left corner). 

Where to Get Help
It’s true that your Mac didn’t come with a printed manual. If you’re cynical,
you might guess that Apple was hoping to save a few bucks. If you’re idealis-
tic, you might assume that Apple is simply concerned about global
deforestation.

In any case, your computer does come with a manual, of sorts — an elec-
tronic one. It’s very terse, somewhat incomplete, and contains no jokes
whatsoever, but it’s there. To find it, open the Help menu, and choose Mac
Help. You get a window that looks something like this:
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You can use this Help Center in two ways. First, you can type a Help topic
into the blank at the top of the window (such as naming files or dialing the
Internet) — and then press the Return key. If you’re having a good night, the
window will then show you a list of Help pages that might contain the answer
you’re looking for; click the name of the topic that seems to hold some
promise, as shown here:

Second, you can click your way through this little Help program. In the previ-
ous illustration, see the heading called Browse Mac OS Help?

By clicking that headline, and then (on the next screen) by clicking the
topic you want, you can often home in on the precise Help article you’re
interested in.

Pit stop
Shut the Mac down now, if you want (flip back a few pages to the section
“The big turn-off” for complete instructions). Or just walk away, confident
that it will put itself into an energy-saving Sleep mode after half an hour.

Chapter 2 shows you how to harness your new mastery of icons and win-
dows to begin organizing the clutter of your life.
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Top Ten Similarities between
You and Your Mac

Before you move boldly forward to the next chapter, ponder the following
frightening similarities between a Mac and its owner:

1. Each is pulled out of a very special container on Day One.

2. Each is most attractive when it’s young.

3. Each has slots to provide adequate ventilation.

4. Each reacts to sudden movements of mice.

5. Each may crash when asked to do too much at once.

6. Each has a button in (or on) its abdomen.

7. Each lights up when turned on.

8. Each occasionally enjoys a good CD.

9. Each may be connected to a phone line for days at a time.

10. Sooner or later, each goes to sleep automatically.
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